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X-Analysis for Windows User Manual - Introduction

Introduction

X-Analysis, allows technical analysts to graphically navigate through an iSeries application from a
Windows PC. Working in a true client-server mode, X-Analysis automatically cross-references the
database and ensures that what is displayed is always up-to-date and a true representation of the
application on the iSeries.

X-Analysis is a tool for analyzing an application on an iSeries by viewing the Object/Member Lists,
Data Flow Diagrams, Overviews, Program and Normal Structure Charts, Source X-References, File
Usage, Source Code, Object-Where-Used, etc.

General Instructions
When running X-Analysis, execute the commands either by:

Clicking on the relevant buttons on the Toolbar.

Selecting the relevant options from the menu bar.

Selecting the relevant options from the right click menu.

Double click selects the most obvious command.

Function key F1 brings up X-Analysis help.

The libraries are displayed on status bar for the selected application.
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Getting Started

To use X-Analysis, it is important to ensure that all the necessary X-Analysis software is installed (on
iSeries and PC). This chapter details the steps required, to complete the installation and initialisation
process.

X-Analysis can be installed onto the iSeries from CDROM.

It is recommended that you read this chapter thoroughly before commencing any part of the
installation and initialisation procedures.

Checklist

Please ensure that all the items listed below are in place.

Authorisation Code

An Authorisation Code is required to run X-Analysis. If you do not have an Authorisation Code, this
must be obtained from Databorough by completing a Licence Code Request Form (see Appendix C).

System Requirements

1. IBM Compatible PC running Windows 98, or higher with Internet Explorer 4.0.

2. Physical connection of PC to the iSeries where the X-Analysis server software is
installed.

3. Microsoft Office 97 for X-Analysis System Documentation and running offline version.

Preparing iSeries to run X-Analysis 4

1. Sign on as a suitably authorised user - i.e. a user that can create & restore libraries and who
has sufficient authority to perform commands such as DSPDBR over the libraries to be
documented. At the point where the command MMC@INST is invoked you will need to be signed
on as the security officer or another profile with user profile creation rights.

2. Set the logging level. CHGJOB LOG(4 00 *SECLVL) LOGCLPGM(*YES)

3. If X-Analysis is previously installed then execute following command :

ENDSBS SBS(XRMTCMD) Option *IMMED

4. Place the CD in the CD-ROM Drive.

5. Perform a LODRUN.

6. Review the job log(s) to verify that all objects were restored successfully. Print and save the job
log. Use DSPJOB Option 4 and print the spool-file

7. Remove the CD from the optical device.

4. Continue with Post-Load Activities.

Post-Load iSeries Activities

Entering the Authorisation Code

Before X-Analysis can be used on the iSeries, the correct Authorisation Code must be entered. The
Authorisation Code must be obtained from Databorough by completing a Customer Information Form
(see Appendix C).
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If an Authorisation Code form has been received, please check that the machine number stated on
the Authorisation Code form is the same as the machine number on which X-Analysis has been
installed. If there is a discrepancy, please contact Databorough.

To enter the Authorisation Code:
1. Add library XAN4 to the Library List:
ADDLIBLE (XAN4)
2. Enter the command
X@Psw
3. Now enter the Authorisation Code supplied and press ENTER

NB: If an existing Authorisation Code has been stored in a temporary library during the installation
procedure, copy it back to the XAN4 library.

& Store the security code form in a safe place

X-Analysis Port

X-Analysis uses JT400 Driver to access data on iSeries. The following ports should be accessible on
iSeries:

e Port 8471 for JDBC Database requests.
e Port 8475 for Command Call.
e Port 8476 for Sign On.
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Initialization of an iSeries Application for X-Analysis

Before X-Analysis can be run, the application cross-reference library, the application repository, has to
be built. The initialisation process takes care of setting-up of this cross-reference database.
The X-Analysis Application overview (X4WRKAPP) interface can be used to initialise X-Analysis.

Set the Library List
Change the Library List to ensure the following sequence:

1. XAN4
2. QGPL
3. QTEMP

Use the command EDTLIBL to set the library-list.

Edit Library List

Type new/changed information, press Enter.
To add a library, type name and desired sequence number.
To remove a library, space over library name.
To change position of a library, type new sequence number.

Sequence Sequence Sequence
Number Library Number Library Number Library

010 120 230
020 XAN4 130 240
030 QGPL 140 250
040 QTEMP 150
050 160
060 170
070 180
080 190
090 200
100 210
110 220

F3=Exit F5=Refresh Fl2=Cancel

Library list changed.

EDTLIBL Command screen

Work with X-Analysis/4 Applications

Type the command X4WRKAPP and press Enter. The following is presented.

X-Analysis/4 Work with X-Analysis/4 Applications Databorough Ltd.
XARWKAPP 05:52:26
10 Mar 2005
Enter options, press Enter.
1=Authorities 2=Change 3=Copy 4=Delete 5=Display 7=Notes 8=Libraries
9=Variable Calls 10=App areas ll=Reports 1l2=Initialise 13=Build data model
14=0ffline menu 15=Objects 1l6=Exclusions 17=I/F Files 18=Program standards

X-ref Lib Text Company/division
XAN4CDXA XAN4CDEM Tutorial System
XAN4CDXW Web demo application
Fl=Help F3=Exit F6=Add F10=Cmd Line Fl2=Cancel F24=More Keys

X4WRKAPP Command screen

© Copyright Databorough Ltd. 2005 Page 6
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Press F6 to add an Application.

X-Analysis/4 Work with X-Analysis/4 Applications Databorough Ltd.
XARWKAPP 18:37:51
10 Mar 2005
X-ref Library. . . . . . . . . CUSLIBXA
TEBRE © o o o o o o o o o o o o PROD
Company/division . . . . . . . Databorough Limited
Index src files. . . . . . . . A
Process var & bound calls. . . Y

Include obsolete source
Build data model

Data model match value
TCPIP address

User 1D

X4WRKAPP - Add Application screen

Enter the details of your application, as detailed below, and press Enter.

X-ref Library: The name of the cross-reference Library. Please choose a
name that has not been used before on the system. Use
the command
CHKOBJ OBJ(QSYS/Libname) OBJTYPE(*LIB)

or
WRKLIB LIB(Libname)
to check this.
Text: The description of the application.
Company/Division: Optional description of the company.

This adds a new application as shown below:

X-Analysis/4 Work with X-Analysis/4 Applications Databorough Ltd.

XARWKAPP 05:52:26
10 Mar 2005

Enter options, press Enter.

l1=Authorities 2=Change 3=Copy 4=Delete 5=Display 7=Notes 8=Libraries

9=Variable Calls 10=App areas ll=Reports 12=Initialise 13=Build data model

14=0ffline menu 15=0Objects 1l6=Exclusions 17=I/F Files 18=Program standards

X-ref Lib Text Company/division
CUSLIBXA Demo Application Databorough Limited
Fl=Help F3=Exit F6=Add F10=Cmd Line Fl2=Cancel F24=More Keys

X4WRKAPP Command screen after adding a new application

The Cross-Reference Library has been created.
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Libraries

Select Option 8 to assign the Source and Object Libraries This screen is used to set up the source
and object libraries for an application. These libraries can then be used when initialising the
application and for any other commands which need this information. Sequence determines the order
in which the libraries are placed in the library list.

Following screen is presented when adding libraries to a new X-ref library.

X-Analysis/4 Work with X-Analysis/4 Application Libraries Databorough Ltd.
XARWKLIB 15:25:06
10 Mar 2005
Selected x-ref Library -> : CUSLIBXA

Enter options, press Enter.
2=Change 4=Delete 5=Display

Type Sequence Library

Fl=Help F3=Exit F6=Add Fl2=Cancel Fl6=Print

X4WRKAPP Libraries screen

Press F6 to add the names of the Source and Object Libraries associated with application, and press
Enter. Repeat the steps for each Library. Press F3 when all libraries have been defined.
Note that all Data and Program libraries must be entered as Object libraries i.e. of Type ‘O’

X-Analysis/4 Work with X-Analysis/4 Application Libraries Databorough Ltd.
XARWKLIB 18:48:47
10 Mar 2005

X-ref library. CUSLIBXA

Type . . . . . 0 (0=0bjct, S=Srce,V=Var.Objct,U=Var.Srce,M=Model)
Sequence . . . 1.00

Library. . . . CUSLIB

X4WRKAPP - Add Library screen

The Type may be any one of the following:

O=0bject
S=Source
V=Variant Object
U=Variant Source
M=Model

While the source library contains the uncompiled source files, the object library comprises the
compiled objects for the same.

In addition to setting up standard source and object libraries you can also enter the names of variant
source and object libraries.
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Variant Object and Variant Source Libraries

A Variant Object Library is a library, where objects with the same name as those already existing in
the base library are kept.

The source files of such objects are placed in libraries known as the Variant Source Libraries.

When entering variant source and object libraries you should associate source libraries with object
libraries by assigning the same sequence number or the same sequence number with a decimal
increment.

If there is large number of objects in a Variant Library(s), then it is recommended that a separate

X-Ref Library be created.

Synon Model Libraries

In order to analyse a Synon application, the Synon model library(s) can be specified by putting the
library type as "M". The Initialisation process picks the Data model information in the Synon model
library(s) when creating X-Ref library.

Libraries added to a X-ref library are shown below.

X-Analysis/4 Work with X-Analysis/4 Application Libraries Databorough Ltd.
XARWKLIB 18:48:47

10 Mar 2005
Selected x-ref Library -> : CUSLIBXA

Enter options, press Enter.
2=Change 4=Delete 5=Display

Type Sequence Library

S 1.00 CUSLIB
] 1.00 CUSLIB

X4AWRKAPP Libraries screen after adding libraries to an application

Press F3to exit.
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Initialisation

Getting Started

The initialisation can now be executed. Select Option 12 to do this and press Enter.

Initialise X-Analysis/4 (XA4INITP)

Type choices, press Enter.

Library for X-Ref database .
Submit job .

. > CUSLIBXA Name
*YES *YES, *NO

Press Enter.

The following screen will be presented, and a batch job is submitted on pressing enter.

Initialise X-Analysis/4 (XA4INIT)

Type choices, press Enter.

X-Analysis Library .
Object Libraries . . . .

+ for more values

Source Libraries .

+ for more values

Index Source Files

Include obsolete source .
Process variable & bound CALLS
Non iSeries Code TCPIP Address

. > CUSLIBXA Name
> CUSLIB Name
> CUSLIB Name, *NONE
. > *ALL *CHG, *NO, *ALL, *UPG
. *NO *YES, *NO
> *YES *YES, *NO, *ALL, *SRC
*NONE

If the Submit job option is entered as *NO then the initialisation process takes place interactively.

X-Analysis Library
Object Libraries
Source Libraries

Index Source files

Include obsolete source

The X-Analysis cross-reference library.
The names of the object libraries to be initialised.
The source libraries for the Application

Specify whether or not to create indexes over the source files.
These indexes will allow the immediate display of where used
data. They may be required for the generation of the data
model, depending on which options are taken. If the indexes
are not built now they can be built for an individual source
member at the time it is viewed through the X-Analysis
browser.

If you do not have the source files you cannot index them. You

can exclude individual source files from the indexing process by

entering records in the file XSRCPFEX. This file is duplicated

into the cross-reference library from library XAN4 retaining any

records already there. Choose from:

= *ALL - Build the indexes; replace any current indexes

= *NO - Do not build the indexes.

= *CHG - Build the indexes. Only update the current indexes
where the source has changed since the creation of the
index

Choose whether to include obsolete source or not. Obsolete
source is defined as source members for whom there is

© Copyright Databorough Ltd. 2005
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Process variable & bound CALLS

Non iSeries Code TCPIP Address

Getting Started

another source member with the same name or similar
attributes higher up in the load library list.

This parameter allows you to control how certain program
references are processed. These program references are the
bound modules and service programs and any references
which can be determined by reference to the source code.

If source files are indexed, this option gives more detailed

information for structure charts and data flow diagrams. Calls

to variable program names and bound calls will be interpreted

and added to the program cross-reference data. This will

ensure complete data for structure chart diagrams and data

flow diagrams.

= *YES - Process variable calls, bound calls, service
programs and modules.

= *NO - Do not process variable and bound calls.

= *ALL — Process variable calls, bound calls, service calls and
modules and scan program sources for additional
reference to the prototyped calls

= *SRC - Process variable calls and process calls to bound
procedures only by scanning the source code.

If you are loading JAVA Source Code from your PC into X-
Analysis then apart from entering the IP Address of your PC,
the iSeries User ID and Password need to be entered as well.

& Enter the numbers and full stops without any spaces

Ensure that the correct details are displayed. Press Enter to start build process.

For using Application Areas (Option 10), Offline menu (Option 14) and Program Standards (Option
18), the Application Overview Module has to be purchased.

© Copyright Databorough Ltd. 2005
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Generating the data model/

X-Analysis provides a data-modelling environment on the iSeries. It can reverse engineer a current
application and then automatically generate the data model and process model. The (logical) data
model, or entity relationship diagram, is derived from the physical data model, which is implicit in the
application.

The next step is to generate the Data Model. To do this, select Option 13 on the Work with X-
Analysis/4 Applications menu.

X-Analysis/4 Work with X-Analysis/4 Applications Databorough Ltd.
XARWKAPP 10:16:04
10 Mar 2005
Enter options, press Enter.
1=Authorities 2=Change 3=Copy 4=Delete 5=Display 7=Notes 8=Libraries
9=Variable Calls 10=App areas ll=Reports 12=Initialise 13=Build data model
14=0ffline menu 15=0Objects 1l6=Exclusions 17=I/F Files 18=Program standards

X-ref Lib Text Company/division
13 CUSLIBXA Demo Application Databorough Limited
Fl=Help F3=Exit F6=Add F10=Cmd Line Fl2=Cancel F24=More Keys

Press Enter

Initialise Data Model (XDMODELP)
Type choices, press Enter.

Library for X-Ref database . . . > CUSLIBXA Name
Submit job . . . . . . . . . . . *YES *YES, *NO

Bottom
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F13=How to use this display
F24=More keys

Check if the defaults are correct and press Enter.
This runs the XDMODEL, the principal command required to run the complete modeling process.

© Copyright Databorough Ltd. 2005 Page 12
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Generate Prototype Application (XDMODEL)

Type choices, press Enter.

Function Library

Add/replace model data

Site Library

Add/replace site data

Function type

X-Analysis Appllcatlon Area

Data Libraries 6o o 0o o o o
+ for more values

Synon Model Libraries 5 o o
+ for more values

Derive Foreign Keys

Tolerance Value o

Allow unmatched fleld names

Use ref. fields for deriving

Use field texts for deriving

Overrides Library/Diagrammer

XBMAILERXA
*REPLACE
*FUNLIB
*REPLACE
*GRIDS
*ALL

*NONE

*PGMLOGIC
*NOMAX
*PREFIX
*NO

*NO

*DGM

Name

*ADD, *REPLACE
Name, *FUNLIB
*ADD, *REPLACE
*GRIDS, *LISTS,
Name, *ALL
Name

*NONE

Character value, *NONE

*DATABASE, *DATABASEA...
Number, *NOMAX

*ALL, *PREFIX, *SUFFIX...
*NO, *EXACT, *PREFIX, *SUFFI
*AND, *OR, *NO

Name, *DGM, *FUNLIB

@\ Please refer to the X-REV User Manual for further details regarding Option 13 i.e. Building the

Data Model.

You should attempt to build the data model only if you have purchased the X-Rev Data Modeling

Module.

© Copyright Databorough Ltd. 2005
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Installing X-Analysis Pre-Requisites

The installation of X-Analysis requires the following Pre-Requisites:
1. Java Runtime Environment(JRE) 1.4.2 or above, and
2. Support JARs/DLLs.

For installing the X-Analysis Pre-Requisites double click on XAPreregs.exe.

P

iz X-Analysis Pre-Requisites Setup |

Welcome to X-Analysis
Pre-Requisites Setup Wizard

The Setup Wizard will install x-Analysis Pre-Requisites on
vour computer, Click Mext to continue or Cancel to exit the
Setup \Wizard.

= Back I Mewxt = I Cancel

X-Analysis Pre-Requisites Setup — Startup dialog

Click Next.

© Copyright Databorough Ltd. 2005 Page 14
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o ] T

i'.g!} Z-Analysis Pre-Requisites Setup

Select Installation Folder

This is the folder where ¥-Analysis Pre-Requisites will be installed.

To install in this Folder, click "Mext", To install to a different Folder, enter it below or click.
"Browse",

Folder:
IC:'I,F‘rc:gram FilestDataborought, Browse, ..

fdvanced Installer

< Back I Mexk = I Cancel

X-Analysis Pre-Requisites Setup — Select Installation Folder

Change the destination directory, if required. Click Next.

& x-Analysis Pre-Requisites Setup |

Ready to Install

The Setup Wizard is ready to begin the Typical installation

Click Install bo begin the installakion. IF wou want ko review or change any of vour
installation settings, click Back. Click Cancel ko exit the wizard.

fdvanced Installer

< Back I Inskall I Cancel

X-Analysis Pre-Requisites Setup — Installation Dialog

Click on Install to begin the installation process.
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P

ji X-Analysis Pre-Requisites Setup =

@ Completing the X-Analysis
Pre-Requisites Setup Wizard

Click the Finish bukton bo exit the Setup Wizard.

= Back I Finish I Zancel

X-Analysis Pre-Requisites Setup — Finish Dialog

The installation of X-Analysis Pre-Requisites is now complete. Click Finish to close the dialog.

Installing X-Analysis

For installing the X-Analysis double click on XASetup<Version Number>.msi.

Note: Version Number may change with a different release.
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& x-Analysis Setup |

Welcome to X-Analysis Setup
Wizard

The Setup Wizard will inskall ¥-Analysis on vour computer,
Click Mext to continue or Cancel bo exit the Setup Wizard.

= Back I Mexk = I Cancel

X-Analysis Setup Dialog

Click Next.

iI‘E_. X-Analysis Setup x|

Ready to Install

The Setup Wizard is ready to beqgin the Typical installation

Click Install b beqgin the installakion. IF wou want o review or change any of wour
installation settings, click Back, Click Cancel to exit the wizard,

fdvanced Inskaller

< Back I Inskall I Zancel

X-Analysis Setup — Installation

Click Install.
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& x-Analysis Setup |

@ Completing the X-Analysis
Setup Wizard

Click the Finish bukton bo exit the Setup Wizard.

= Back I Finish I Zancel

X-Analysis Setup — Finish Dialog

Once the installation is complete the above dialog is presented. Click Finish to close the dialog.

A program group called X-Analysis is created having short cuts for:

¢ X-Analysis Help -0 x|
e Uninstall X-Analysis : T SR
« Data Transfer Utility J File Edit Wiew Favorites o
e Read me J ™ o »
i | Back = § -
e X-Analysis (Offline) o 2 ir
¢ X-Analysis Configurator J.ﬁ.ddress |,_} w-Analysis j = Lt
e X-Analysis Tools
Activate Port Listener _ LIs E
Initialize Java Code HH s
X-Browse Configuration Wizard w-fnalysis  Data Transfer  Read Me
e X-Analysis (Online) Taals Lltilitsy
o o 0
= ] Ed
ninstall n-finalysis #-finalysis
w-Anakysis [FFling) (online)
LT ))
9
w-Anakysis r-Analysis
Configurator Help

X-Analysis Start up folder
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Configure X-Analysis

Getting Started

Windows Start Menu > Programs > X-Analysis > X-Analysis Configurator pops up a configurator

dialog which allows user to configure basic X-Analysis settings.

¥-Analysis Configurator

|L| zer Interface Language

|H ozt code-page II:IDB? IInited States j
|S erver Timeout [milli zec.] IEEIEIEIEI

|Ma:-:. Structure chart levels |14 j

|Default Source Editor 7 Code/400 Editor £ 5250 E mulatar

Drefault Settings |

Cancel |

X-Analysis Configurator

Here user can pick the Language, Host code page, server timeout and structure chart levels.

Running X-Analysis

Start X-Analysis from Windows Start Menu > Programs > X-Analysis > X-Analysis (Online). The X-

Analysis Sign on dialog is displayed.

Hast Mame |192.1EB.1?EI.1

Uszername IMﬁ'-.FEK

Pazzword ||

Databorough®

alysis

if you =ign on as SRANALTSIS

i (] I Cancel

MOTE: Mo Data Management Dptions are available

d to:

© Databorough Lid. & Others 2005 All Rights Reserved
Licenced Material - Property of Databorough Lid.

X-Analysis Sign on dialog

1. Enter the TCP/IP address, or the Computer Name or Network ID of the iSeries to be accessed.

2. Sign on as a specific user using iSeries profile.

© Copyright Databorough Ltd. 2005
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3. Click OK.

X-Analysis presents List of Application Libraries screen.

W8, x-Analysis - List of Application Libraries : i [ |

File Application Action  Wiew Ohbject indow Help

B & | @ %8By X | B & J | & om0 | %) [ e

=-Fl cUsLIEzA - Demo Application |

Application Libraries screen in X-Analysis

X-Analysis brings up the application libraries screen listing the registered applications.

The installation process registers a demo application CUSLIBXA.

Status bar
Status bar on X-Analysis window is divided into six sections. They are:

General message section

Host Name section

User Name

X-Analysis Library section
X-Browse Library section
Database Library section

Data Model information section

Data Wodel Status

General Message Section Host Tilame X-Analysis User Name 3 Analysis Library X-Browse Library  Database Library I
) 1 1 1 1
Ready [1921621701 [WER [RANACDHA HAORDERS [AMACDAST 5

X-Analysis status bar

The sections hold relevant information at different stages of navigation. The data model information
section reflects whether the Data Model information has been built for the current application being
browsed. If the data model is built, its shown with the green background else it's grayed out. The
status bar below gives one such state.
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Tool bar buttons

Getting Started

The tool bar buttons with their specific purpose are tabulated below:
Function

Return

Print Preview

Print

Application
Properties

Member List

Object List

Jump To

Object
Used

Variable
Used

Zoom
browser)

Data
Diagram

Where

Where

(source

Flow

Structure Chart

Button

Purpose
Returns to the previous screen.

Presents a print preview of the diagram on
the screen.

Prints the contents of the view.

Displays Application Property Dialog for
selected application.

Displays the member list for the selected
source file and library.

Displays the object list for the selected
source file and library.

This displays all the options available for a
particular member for faster access viz.,
Browsing of source code, Viewing Data
Flow Diagram, Structure Chart and more.

Displays all the instances of a particular
object in an application wherever referred.

Displays all the instances of a variable
used in the source listing.

This option displays the source code of a
selected member in the Source Browser.
Select a member by clicking on it to view
its source.

Presents the Program/Object centered
Data Flow diagram. To view the data flow
diagram of a particular object, the object
should be selected from the member list
first. Relevant message is shown if no data
is present for the selected object.

Displays the structure chart of the selected
object. Message is shown if no data is
present for the selected object.
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Getting Started

Position to
Search Text

| B o4

First button is the Position to
button. Second button is the
Search Text button.

Bookmark

About

el | #;

Positions to the Object/Member/Sequence
No. specified in Position to/ Search Text
box on the View. Search Text is available
on the Source browser, Member and
Object list view. On Member and Object
list view it works on the Description
column only.

Alt+P sets focus on the Position to/
Search Text box and Shift+F4 is the short
cut key for the Search Text button.
Invokes the Bookmark manager.

Displays the version and copyright details
of the product.
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Menu bar items

Getting Started

The Menu bar comprises the following menus and menu-items. evil

Menu-items on the menus are enabled, disabled, added and changed depending on the view.

Menu / Menu-item
File

Connection

Prink. .. Ckrl+F
Prink Prewview
Prink Setup...

Export bo 15 Word

Return
Exit

Application

Properties ...
[ew ...
[pdate
[elete

Dpen Application Falder

Documenter:

Action

Jurnp to
Position ko
Search Description

Ohject Lisk
Member List

‘ariable Where Used
‘ariable Where Updated

Irverview Structure Chark
Data Modelling Diagram

Bookmark ...
Drocument Ehis list ...
Expart bol5 Visio

Invoke X-Browse For Data Dictiomary:

Purpose

Connection: Displays connection status and the job details.
Print: prints the contents on the view.

Print Preyview: Brings up the print preview of the view.
Print Setup: This option allows for changing margins,
paper source, paper size and page orientation for the entire
document.

Return: This option returns to the previous screen.

Exit: Exits X-Analysis.

Properties...: Displays the properties for the selected
application.

Jump To: Pops-up a dialog for faster access to various
object specific views.

Position To: Positions on the List/View to the
Object/Member/Sequence No. specified in Position to Box.
Search Description/Text: Its available on the Source
browser, Member and Object list views.

Object List: Displays Work with Objects dialog.

Member List: Displays Work with Members dialog.
Variable Where Used: Displays all the instances of a
variable used.

Variable Where Updated: Same as Variable Where Used,
but displays only those source lines where the field is
updated.

Bookmark...: Invokes the Bookmark manager for more
than one bookmark.
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View Detailed DFD/SC: Brings up the detailed view of

Diagram/Charts.

Detail Expand Level: Specific to Structure Charts.
Collapse Level: Specific to Structure Charts.

Expanid Level Expand all: Specific to Structure Charts.

Collapse Level Subset: Subsets the Member/Object List Display.

Expand &l Refresh: Re-generates the relevant view.

- Small/Medium/Large Font: Sets the display font on the
source browser view.

Reftest

Source Level k

Saurce Code

Indented Source

Pseuds Code

Business Rules Code
Eusiness Rules Fseudo Code

Flawchark im ME Yisio

Large Fonk
Object Zoom Source: This option opens object source browser.
Where Used: This option displays the object where used
Zoam Saurce screen.

Where Used

[Data Flow Diagram
Structure Chart Diagram
Program Structure Chark

annotate
MMatk Far Dacumentes
Matk all Far Documenter

Invoke KBrawse

Window

#-Bnalysis - List of Application Libraries

¥-Analysis - Objeck Lisk of *ALLFALL*PGEMFALL*ALLI*ALL - Tokal Objects: 70

®-Analysis - Source Lisk of CUSFMAINT in CUSLIB/QRPGLESRC Lines: 297, View Level: 5

¥-Analysis - Data Madelling Diagram For *ALL - Tokal Objects: 24 Objects with no relations not included
Cbject Centered Data Flow Diagram For PROJECT - Total Objecks: 13

v Windows., ..

Data Flow Diagram: Presents the data flow diagram.
Structure Chart Diagram: Displays the structure chart
diagram.

The windows menu shows a chronological list of windows that have been opened by the User to
reach the current window. First five views appear as Menu items. If there are more than five
windows open then the rest are shown under the v* Windows... submenu item.
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X

X-Analysis for Windows User Manual

X-Analysis History

Select Window : Activate I Cancel |

Windiow

F-hnalysiz - List of Application Libraries
H-Analpziz - Object List of “ALL&SALLAPGEMASALLAALLSALL - Total Objects:

Habnalesiz - Source List of CUSFMAINT in CUSLIB/ORPGLESRC Lines: 297,
Habnalysiz - Data Modeling Diagram for 5aLL - Total Objects: 24 Objects with

Object Centered D ata Flow Diagram for PROJECT - Total Objects: 13

F'ru:ugram Centered D ata Flow Diagram for PROFE<T - Total Objects: 2
* - Member List of CUSLIBAQDDS! fELLAALL - Tatal Members:

1 | i

Displays the history of the options taken.

Help: Pops-up view specific help.

Help
About X-Analysis: Displays copyright and registration
Help information.
Help

About X-Analysis. ..

For information regarding the advanced toolbar and menu bar options, refer to Appendix A.
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Right Click Popup Menu
This menu pops-up when an object or a source line is right clicked.
<Object Name> Name of the object to work with

CLISTS Zoom Source: Brings up the object’s source listing
Structure Chart Diagram: Presents the object’s
SO =EE Structure Chart
£, Diata Flow Diagram Data Flow Diagram: Presents object’s Data Flow
Diagram

W Strichure Chark Diagranm
W P oo A Skruckure Shark
B Cata Madelling Biagram

File Field Details: Details of the fields of the file
Object Where Used: Object’s reference information
Variable Where Used: Find usage of a variable

File: Field Details Variable Where Updated: Same as Variable Where
Screen DesigniRepart Layout Used, but displays only those source lines where the
B Object Where Used f'_eld '5_U pdated. ) o
S Variable Where Used File/Field Where Used: Find usage of a field in that
Variable Where Updated file. <Specific to Source Browser view>.

File/Field Where Updated: Same as File/Field
Where Used, but displays only those source lines
where the field is updated in that file. <Specific to

[IFs [ Bocess Paths
Membet E-ref

Annotate Source Browser view>.

annotate Feld Member X-ref: This option appears for a variable in
[Mark For Decumenkes Programs

Mate Infa...

View Daka

Addibn ppplication Area
Addibo Application Area with Related Objects
it fram Application Srea

Apart from Zoom Source and More Info, all the other Right Click menu options on an object from a
Variant Library are disabled.
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Application Libraries View

Application Libraries view is the first X-Analysis view. It lists all the applications added using
X4WRKAPP command on the iSeries.

Work with Application

Application library can be selected in the following ways:

e Expanding the application node by click on the “+" sign next to an application X-Ref library.
¢ Single-click on an application.
e Double-click on an application to bring up Source Files listing.

On the List of Application Libraries, click on the “+” sign next to an application, say, the XAN4CDXA -
XAN4CDEM Tutorial System.

W8, x-Analysis - List of Application Libraries ' -0 x|

File Application Action  View ©Object  Window Help

S Hra BRSBTS AR =

=gl CUsLIEzA - Demo Application |

List of Application libraries

This expands the application node, listing the sub-items, Files, Programs, All objects. The Application
areas, if created for the application, are also listed.

B8, x-Analysis - List of Application Libraries ' -0 x|

File Application  Action  Wiew Object  MWindow Help

B &[T X (B BT 5B B o] % ey
Eﬂ CUSLIBXA - Demo Application:
-y Files
Programs
% &l Objects
LT Source Files

i Daka Model Diagram
i B= Orverwienw Struckure Chart

Application library expanded
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Application Properties

Settings for an application can be displayed at any stage while browsing through the
application. To display application properties click Application Properties button on the tool bar
or select Application > Properties from menu bar.

The dialog lists the Object and Source libraries associated with the application.

The default Application Folder is created under <Default Drive>:\Program Files\Databorough\X-
Analysis\<IP Address of Host>\ in the name PCF_<Application Library>.

If working in offline mode, then instead of a folder named after the IP Address of the host computer,
a folder named ‘Offline’ is created.

Application Properties ; ; ﬂ

s-Ref Library  [CUSLIBRA

Text |Demu Application

— Object Libranz]
CUSLIB CUSLIB

— Source Libram(z)

Spplication Folder I | Cloge I

Application Properties Dialog
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Work With Objects

The Object list dialog is presented for the selected Application Library, when opting for Work with
Objects on right-click menu or clicking on Object list button on tool bar.

8%, x-Analysis - List of Application Libraries

File Application Action  Miew Object  Window  Help

B S & X | B BT S5

CUSLIBXA - Demo Application Cbject Lisk
- work with Dbjects i x|
Programs TR
el All Objects — Application Area

----- & Source Files

i vy Draka Model |
L C2 Crveryiew St

M ame Deszcriphion

All Members Selected

— Object
Library
[ ALl =l
Mame Type Altribute
| | | “FILE =l JFF |
Text |
— Function Atrributes
Component Status Function Type

=il | | Ll ]

Ok Cancel |

Work with Objects dialog

Double-click on the Files item under CUSLIBXA, alternatively right-click on FILE and select Work with
Objects option; this presents an object list dialog. The Type/Attribute is set to *FILE/PF. Click on OK
button to get to the Object list. The list also shows the object’s creation, used and changed dates.

B8 X-Analysis - Object List of *ALL/*ALL/*FILE/PF - Total Objects: 38

File Application Ackion  Wiew Object ‘Window Help

R - e e N
7 ; =
FFCusLIE CNTACS *FILE PF Contacts
FF cusLIE COMDET *FILE PF Conkract Detail
FFCusLIE CONHDR *FILE PF Conkract Header
FFCusLIE CLISF *FILE PF Sikes
FFcusLIE CLISGRP *FILE PF Customer Groups
PFcusLIE CLISTS *FILE PF Customers
FFcusLIe DELIVA *FILE PF Delivery Areas

Object list of PFs
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Similarly, double clicking on the Program item under CUSLIBXA also brings up the Work with Objects
dialog, but the Type/Attribute is set to *PGM/*ALL. Double clicking on All Objects or clicking on the
Object List button sets it to *ALL/*ALL.

To narrow down the search, the Object Name on the Object group may be mentioned as well. It can
be :

= FALL

= Member Name (maximum 10 characters long).

= Initial characters of member name followed by an asterisk e.g. C*, OE*, etc.

Besides the other settings, following Functional Attributes can also be specified on the Object List
dialog:

Component Status:

*A Parent or top-level program
i.e. calls other programs but is not called itself.
*B Program is called by another and also calls other programs.
*C Program at the end of a program tree — does not call other programs.

*D Stand-alone program

Function Type:
This describes the function of the object and is based on COOL:2E definitions.

& The Function Attributes apply to program type objects.

The first screen is sorted on Object Name in ascending order. To change the sort order or to sort on
any other column, click on the respective column heading.

Jump To dialog can be invoked by pressing Enter on the Object list view. This puts the object on that
row in the Object/Variable textbox of the Jump 7o dialog. From here the user can select the desired
option. Also, the user can right-click on the row to bring up the pop-up Menu to select an
option.

Subset List

This option allows to subset the current Object List in the view. Select Subset on the View menu in
Object list view.

The criteria is now limited to specifying the:

1. Object Name

2. Type

3. Attribute

4. Object Text

5. Functional Attributes
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Source File View

Source File View contains qualified names of all the source files present in the application. This view is
reached by double-clicking (OR Right-click option, Work with Source Files) on Source Files sub-item
on an application in the Application Libraries View.

%, x_Analysis - Source File List for: CUSLIBXA Total Objects: 11

File Application  Action  Wiew Object  ‘Window Help

& s B T o B B 0P S0 B0 o | 2 B

F|-{I CUSLIBXA - Demo Application Source Library | Source File | Source File Text
I Files CUSLIE QICBLSRC CBL Source File
Programs CUSLIE QICLSRC
ol 4l Obiects CLSLIE QDDSSRE
_____ =i Source Files CIISLIB QLETSRC
_____ "% Data Mode Diagram CUSLIB QRPGLESRC RPGLE Source File

o . CISLIE QRPGSRC

- B= Oweerview Struckure Chark CUSLIE QRPGSRCREY

Source Files List

Double-click on a source file to bring up Member List view listing all members of the source file.

Source File
_ E 3R Piz5H A )
& CIUSLIE QRPESRC Zalculate Interest
& CUSLIE QRPGESRC CE90SR RPG Apply transackion ko an account
S CUSLIE QRPGESRC CE906R RPG Back-ouk account
tCIUSLIE QRPGESRC CEO07R RPG Transaction Account Update
£ CUSLIE QRPGSRC CFD211 RPG Indicator Restructuring Example
& CUSLIE QRPESRC CoMO01 RPG Conkract Enkry
5 CUSLIE QRPGSRC COMFIA RP3 FIx contrack DETAILS

QRPGSRC Member List

However, the Member List may be brought up by using the Member List button as well.

Here user can specify the criterion to prepare a set of Members to work with. ]
1. Select Source File and Library using the drop list.
2. The Member Name on the Member details group can be:
= KALL
= Member Name (maximum 10 characters long).
= Initial characters of member name followed by an asterisk e.g. C*, OE*, etc.
3. Select type from the drop list.
4. Click OK
The list of members for the specified criterion is presented in the Member List View.

The first screen is sorted on the Member Name in ascending order. To change the sort order or to
sort on any other column, click on the respective column heading.

Subset List
To view the subset of the current Member List, select Subset on the View menu in Member list view.

The criteria is now limited to specifying the
1. Member Name

2. Member Type

3. Object Text
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Jump To

Application Libraries View

The primary requirement of an analyst working with a case tool is to get quick and enough

information about an object. X-Analysis facilitates this by providing faster access to the
objects using the “Jump To” utility. This utility is available from any screen using the Jump 7o

button on the toolbar.

7

Jump To displays all the options available for a specified member, object or variable for fast access to
Source Browser, Data Flow Diagram, Structure Chart, Object Where Used, Source X-Reference and

Variable Where Used.

OhjectMariakble:

|CUSF

" Zoom Source

{~ Data Flowr Diagram

{ Structure Chart Disgram
" Program Structure Chart
" Ohject Where Used

" Member H-ref

 “ariakle Where Used
[[Physical File] / Field Mame)

" “ariahle Where Updated
[[Physical File] / Field Mame)

" “ariakle Where Defined
[[Phy=zical File] / Field Matme)

| Data Maodeling Disaram

Exit

Jump To Dialog
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Information about an Object

Information about an Object

More Info

More Info option provides detailed Object Information like name, library, type, attribute, etc. This

option is available on the right-click popup menu only.

More Info option selection presents Detailed Object Information dialog. This dialog has information
depending on the type of object. Generally, it presents object details viz. Name, Object Description,

Library, Type and Attribute.

Aktribuke

er Entry

DEOO] Er Enquiry
% CLUSLIE OEQO] Huck Enquiry
E CUSLIB DEQQe 2] £00M J0urce Forner Enquiry)
. .
< CLSLIE OEQQE : E Invvaices
ECUSLIB OEqp: SaData Flow Diagram et Entry
E CLISLIE OEME T otruckure Chart Diagrar

B Brooram Steuckire Chark
WY Ciaka Madelling Biagram

fnnatate Feld
Mark For Dacumenter

et Entry Menu

Mare Info. ..

More Info Option

For program type objects it also presents - Function Type, Roll-up Group and Component Status.

¥-Analysis - Detailed Objeckt Infurmatiq:'

— Object Details

X

Mame Order Entry

Librany IELISLIB
Type I"F'GM Attribute RFG

— Functional Attributes

Function Type IEDTFIL

Roll-up Group UPD

Component Status I"E

More Info for a Program Object
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For a PF object, More Info presents the following details:

X-Analysis - Detailed File Information x|

— Dbject Detailz

Mame Im— Sites
Library IW
Type I"FILE—
Attribute IF'F—

More Info for a PF object

Data Flow Diagram

Data Flow Diagram is the pictorial representation of the program/object, showing the files and
programs accessed by the subject program. The types are:

e Program centered

e Object centered

e Command centered

Program Centered

Files can be accessed for Input, Output or Update by the program. Data Flow Diagram displays the
logical flow of the data. Workstation and/or Printer files used by Program are shown as well. The
program’s DFD also displays the programs called and the programs calling it. Such diagrams are
Program centered Data Flow Diagrams.

CED01
Crrder E mtry
4 FTYFES 4 CEOMDF 4 OEMERMU CEODS 4 CUSTSLE
F roducts i C rder E rtry Display Order Entry Menu Crder Emtry by
Cusnoi epresentative
—_— - -—_— -

Program Centered DFD

Command Centered

A Command Centered Data Flow Diagram is same as Program Centered Data Flow Diagram except
that the object for which Data Flow Diagram is drawn is a Command object.

The legends bar at the bottom of the screen depicts type of objects displayed on DFD. Program
Centered DFD and Command Centered DFD both display same legends bar.

Legend: | Main | Update |  Display | Fint [ Input [ Output | CaledPgm | CalingPam | Command | Indetemminate
Program/Command Centered DFD Legend Bar
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|

Object Centered

An Object Centered Data Flow Diagram displays the object’s usage by various programs and Logical
views.

CUSTS
Customers
_—_—————ee
4 COMNDDT 4 FURD 4 SEC1 ZACUSTS 4 EZCOMNOD 4 OEODZ 4
3 Contract Entry 3 Furchase Crder s Security Code LACUSTS Shadow b | Shadow program for Crder Enquiry
Emtry Report F rogram ZACOMNHDR.
4 OEO0G 4 SCUSTY l 4 CUSMTH CUSCPY 4 CEOD 4 OEOD4 4
3 Frimimvoices le—| Generate P urchase le—ail/pdate Maimtenance Customer Copy |5 Crrder Emtry E 3l Customer E 3l
Record Marths = nquiryMaimenance|
e S —— e — e — e -
- OEODS CUSTSLA CUSTSLZ CUSTSLZ2 CUSTSL4 CUSTSLS
le—s| Order E ntry le—s| by Cus le—al by by e o by he—al by
SrpfCustomer presentative C ustom| FusnoUF epresentati v i stributor /T ustomer Statement/Customer
—_ —_

Object Centered DFD

The Object Centered DFD’s legend bar, at the bottom of the screen, depicts the type of object
displayed

Legend: | tain | Update [ Display [ Print [ Input | Output | CalledPgm | CalingPgm | AccessPaths | Indeteminate

Object Centered DFD Legend Bar

Detailed Data Flow Diagram
Detailed data flow diagram displays field details of the objects present in the data flow diagram.

CUSTSLE
by CusnoR epresartative

e

1 2 2 4 )
- ©E 002 - (=] ulul=) 4 CEO0 OE 004 4 CEOOS - CUSTS
Order E nquiry P rint Invoices Order E ntry Customer Order Entry Customers
= nquiry Ml aintenance|
N
FIELD USRGE OF OBJECTS ASSOCIATED WITH CUSTSL3
1 Input DEDOZ Order Enguir
.l ¥ 4 Update/Output OE0D2 Customer Enquiry/Maintena
Input: CTsH0 - Prospect Mo
Output: CUSHO - Praspect No
2 Input ODE0DE Print Invoices
5 Update /Output OE00E Order Entry
Input: CUSNO - Prospect Mo
i o Output: CUSHO - Prospect No
Input: HUTGIVA - Credit Limit . X
Output: DCODE - Distributor
Output: KWFOWo - Last Pay
3 Vpdate/Output O0E001 Order Entry N P
Jutput: HWGIVA - Credit Limit
Input: CITEND - Prospect No

0 : HITNO

Detailed Object Centered DFD
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Object Convention
The Data Flow Diagram of a selected object can have different types of items.

Main for Object Centered DFD
w Depicts the file for which DFD has been build. It has
= . connecting lines with arrows pointing to the objects it

accesses, is accessed by, sends input to, takes input from,
or gets updated.

Main for Program Centered DFD

Depicts the program for which DFD has been build. It has
connecting lines with arrows pointing to the objects it calls,
is called by, sends input to, takes input from.

Main for Command Centered DFD

Depicts the command for which DFD has been build. It has
connecting lines with arrows pointing to the objects it calls,
is called by, sends input to, takes input from.

Input

Depicts the input file to the main program. It has a connecting line with an
arrow pointing into the file.

CHSE 2
Leuar L

|
isnes by NUMber
1

Represents the output file. It has a connecting line joining it to the main
program with the arrow pointing out of the file.

Depicts the update file. It has a connecting line with arrows at both ends

by showing data sharing with the main program.

Cusno/R epresentative

Depicts the input data area to the main program. It has a connecting line
with an arrow pointing into the file.

Output Data Area

A i Repres_ents the outp_ut data area filg. _It has a conne_cting line joining it to
the main program with the arrow pointing out of the file.

Update Data Area

T Depicts the update data area file. It has a connecting line with arrows at
both ends showing data sharing with the main program.
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Printer

EO0BR

Irvoice

Work Station

CEMENUDF
(Order Entry Menu

2
|
|
|

OEMENU
Orcier Eniry henu

Access Path

I CLSTAL
%Orders by Product

| E— —

Command

AT
Initiglis= A-Analysis’d

Input & Outpu

CRTFILEA

Called Program

Represents the programs used for printing. It has a connecting line joining
it to the main program.

Represents the programs used for display. It has a connecting line joining it
to the main program.

Represents the programs called by the main program.

Calling Program

Depicts the program which calls the program whose Data Flow Diagram has
been constructed. The arrow head points out.

Depicts the logical file related to the parent object.

Depicts Command object — calling parent object, or called by parent object.

t file
Represents an input and output file.

Update & Output file

CSTMRS
ustomers

Represents an update and output file.

Input file to Trigger Program

CSTTRGM
CSTMRES Trigger
F rogram #1

Update file to

CSTTRGO
CSTMRS Trigger
F rogram #1

Represents an input file to Trigger Program.

Trigger Program
Represents an update file to Trigger Program.
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The above items are for a program centered DFD. In case of object centered DFD, the programs

using the object as input, output, update are shown as below:

OE00Z 1 Program using the object as input.
Crrder E nguiry

GCNTACT n Program using the object as output.

Generate F rospect
R ecord

OEQ0 Program updates the object.
(Crder B mtry

The linkages and arrows are depicted in the same fashion as on program centered DFD.

Field Usage

Field Usage information of the file can be displayed by clicking on the
button available on the top left/right corner out side the object. It lists
the file fields used by the program.

X-Analysis Informer

A

CUSCPY
Customer Copy

Field Usage in OEOOS

Field Mame Field Type | Description

CLISMO Cutput Prozspect Mo
DCoODE Cutput Distributor
ANEONVD Cutput Last Pay
AU E LS Cutput Credit Limit
AMJUIND Cutput Bank Afc

Field usage in X-Analysis informer dialog

The dialog lists the parameters passed to the called programs for Program to program link.
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If the Data Flow Diagram for an object has Variant Objects under its purview then they are
indicated by the name of the Variant Library before the Object Names.

Cbject from

base library Variant Objects
4 2 E 001 ADZIDE 001

Crrder E mtry Crrder E mtry
E— E—

CUSTE

Customers

AO0ZSOE 00
Zrrder E mtry

CUSTSLE
by

inouF epresental

DFD of CUSTS with Variant Objects displayed

In the above diagram, VA02 and VAQO3 are the two Variant Object Libraries. Object in a variant library
is denoted by <Variant Library Name>/<Object Name>.
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Structure Chart

Structure Chart Display gives a graphic representation of how the control passes from one program to
another program within the application. The Structure Chart starts with the program specified on the
request and grows top down, illustrating all programs invoked by the specified program.

'= ®-Analysis - Structure Chart for OEMENU - Total Objecks: 14, Displaye
File Application  Action  Wiew Object  Window  Help

. Bz
¢« Raslg|bsdT RS EM W
CEMEMU OTH

HCrder E mtry Meanu
OE 001 EDTFIL
Zrrder E mtry
QEQO0Z DEFFIL DSP
Crder E nquiry
OE 003 DSFFIL DSP
F roduct E nquiry
OE 004 EDTFIL
Customer E ngquiryMaintenance
OE 006 FRTFIL FRT
Frirt Imvoices

Structure chart

Structure Chart legend at the bottom depicts the type of object displayed.

Legend: | Update | Display [ Frint | Input | Clutput | Command | (Others [ Indeterminate
Structure chart legend bar

Structure Chart can be expanded/collapsed using the button on the lines.

Lelyd
A
ALE
Expand Collapse
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Detailed Structure Chart

Detailed structure chart option under View menu brings up the file details, describing the functioning
of the object.

"= ®-Analysis - Structure Chart for DEMENU - Total Objects: 22, Displayed Dbjecks: 1 to 22
File Application  Action  Wiew Object  Window Help

|« s &b BT S5 B

QEME ML OTH

Crrder E mtry Menu
F rogram: Crder E mtry Menuo. A principal function ofthis program is to call

certain programs.
—
Disply - - CEMEMUDF

QE 001 EDTFIL

2 rder E mtry

F rogram: ©rder Emtry. A principal function of this program is the online
maintenance of CUSTSL3E, the by Cusno/R epresentative file through a subfile
display. Data is retrieved from the following files: PTYFPES. P arameters
are passed to the program when it is called. The program is called by
CEMERU, OE QDS

e —
Disply - - CEOMMDF

Detailed Structure chart

File Usage

The File Usage Option for an Object selected from a Structure Chart, if available, displays File Name,
File Type and Description. This option is available only on the Structure Chart.

MoEom X-Analysis Informer
Crrder E mtry

File Usage in YWCUSL

Customer Letter

File Mame File Type Description

LSKLSRC Output

SkLMO Data Area

CLETSRC Update

HEWER Data Area Customer Letter

LSIGERC Input

LISYSPRT Input Customer Letter

|_> 21 FTTFR Ikt Muctnmar | attar

File Usage —— C\ MCUSL FRTFIL

File usage in X-Analysis Informer dialog
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Object Where Used

The Object Where Used (OWU) lists all the instances in the application where the specified object has
been used/referenced.

On a Member List of DDS sources, right-click on the CUSF object and opt for Object where used.

B2 X-Analysis - Member List of CUSLIB/QDDSSRC,/*ALL/*ALL - Total Members: 108

File Applicakion  Action  Wiew Object  ‘Window Help

L By
el s &b 4T 55 E 0w s oo
Librarwy I Source File I A Mame I Tvpe I Description
LFcusLIE QDDSSRC CONHDRLS LF by Debtor/Date
LF ClsLIE QDDSIRC CONHDRL4 LF by Debtor/Date/Re
LFCisLIE QDDSIRC CONHDRLS LF by Date
i LISLIE QDDS3RC = o
LFCUsLIE QDDSSRO ol CUSE
LFcusLE QDDESRC il
LF cusLe QDDSSRC clERE e
LFcusLIE QDDSSRC 1 ;
Data Flaw D
LF CUSLIE QDDSSRC c| EaDatBEAw Rl
LF cLUSLIE QDDSSRE 1 B Stelctore Chark Diagram
LFcusLIe CDDSSRC | M Froaram Stricture Chart
LFcusLIB QDDSSRC Ol P Data Modeling Diagram
LFcusLIE QDDSSRC il
LFCUsLIE QLDSSRC 1l File Field Details
LF cusLis QDOSSRE Cl Screen DesionfBepork Layout
LFcusLs QDDSSRE c1[ E- Obiect Where Lised ]
LFcusLIE CQDDSSRC g
LF CLISLIE QDDSSRC al ¥ variable Where Used
£ CIUSLIB QDDSSRC Cl Variable Where Updated
PFousLIE DDSSRE cl UFs [ fceess Paths
£ CUsLIB O0DS5RE Cliraas bt

Member List view

This produces an Object where used screen listing all the object referring CUSF object.

In case the OWU is performed on a PF (CUSF in this case), then besides listing the objects using
CUSF, the objects using the LFs built on CUSF (e.g. CUSFL3) are also reported.

A %-Analysis - Object Where Used For CUSF - Total Objects: 38

File Application Action View ©Object  ‘Window Help

R I s e N I e
j L
: N T
CUSCPY Customer Copy File Read/wWritten To By Program
ZIUSFL1 Sites by Mame Logical File
CUSFLZ Sites by Status Logical File
CUSFLZ Sites by Murnber Logical File
ZLISFLS Sites by Dist, & Skatus Logical File
ZUISFLE Sites By Disk, & Mame Logical File

Object Where Used Screen

The source of an object on this list can be reached by selecting that object and pressing Enter key.
Alternatively, double-click on the object row.
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Double Clicking on an object from the Object Where Used List zooms on to the source line where the
first reference has been made.

&l X-Analysis - Source List of CUSFMAINT in CUSLIB/QRPGLESRC Lines: 297, Yiew Level: 5
File Application &ction  Wiew Object  Window  Help

|| B a|E | BT 55 8 0 o o o]
P L L
o044, 00 C cusno chain(e) reust
o045, 00 C if not Hfound{cusfls)
aoog4es.00 C ewval #¥inlr = ¥*aon
oo47 .00 C return

C endif

o04s. 00

Source List of CUSFMAINT

Double Clicking on CUSFMAINT displays the source list with line 44 selected where the first reference
of CUSF is being made. However, there may be more references to CUSF further down the source list.

Source Browser View

Right-click on any member/object on the Member/Object list pops up a menu. This menu can be used
to produce the Data Flow Diagram, Structure Chart, etc. of the object. All these options are detailed
in the subsequent Chapters. We shall talk about Zoom Source here.

Double-click on any member/object on the Member/Object list also opens the member source in
the Source Browser view.

Zoom Source

Source Browser display follows the pattern similar to IBM’s SEU and is equivalent to viewing a source
member in SEU browser mode. However, the Source browser display provides a number of additional
powerful features. This not only allows the user to directly browse another source, but also to
continue with another zoom once there. Further, user can return back to the same point on the
previous screen from where the zoom was issued.

&l X-Analysis - Source List of FAXSHT1 in CUSLIB/QRPGSRC Lines: 53, Yiew Level: 5

File Application  Action  Wiew Object  Window  Help

e s |b s T 5% Eom s o ok M
o P W L e e e L e S e i
oool.oo H ¥
oooz . oo FCUIFLY TUP E 4 DISE
ooos.oo E BFIE 17 1
ooog. o0 E [ERINN 2 1
ooos.oo I "CLRPFM QTENF/QLETSRC-C dCHD
oooe.00 I ' LETTER'
ooow.oo C *ENTRY PLIST
goos. oo C FPARHM LETTER &
goos. oo C FPARHM NED3 3o
ool1o.oo C¥ Find fax nurber

Source Browser View

Note the following on this view:
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e The display positions the screen to the beginning of C-Specifications for RPG programs and
Procedure Division for COBOL programs.

¢ Double-click on the line performs Member X-Reference or Object Where Used depending on
whether a variable or object is present on the line, giving preference to Member X-reference, in
case it's a Program. On Physical/Logical Files, Global where used is performed for the field on that
line for that file.

¢ Double-click on the sequence humber/Date scrolls that line to become the first line on the view.

¢ Right-click pops up a menu with the name of the Object/Variable on the top and menu options
available on it.

Information about an object on a view can be had by selecting/highlighting the object and

¢ Right-clicking on it to bring up context-menu to choose an option.
e Invoking Jump To and selecting an option.
¢ Double-clicking to bring up a designated view depending on the current view.

In the application more than one source member may exist with same name. For example, in the
application XAN4CDEM both, QRPGSRC and QRPGLESRC, have a member ZACUSF. The object
ZACUSF corresponds to member ZACUSF in QRPGLESRC, while ZACUSF in QRPGSRC is obsolete. In
such case if any information is requested for the obsolete source member, then Obsolete Source
Member message is displayed as shown below.

Obsolete Source Members show up only on the Member list. The options possible on obsolete
Source Members are Zoom Source and More info...

The right click menu on the source view gives the following options:

e Variable Where Used: Displays source lines where the variable has been used throughout the

application.

Variable Where Defined: Displays source lines where the variable was defined.

Variable Where Updated: Displays the source lines where the variable has been updated.

File/Field Where Used: Displays the usage of a field in that file.

File/Field Where Updated: Displays the source lines where the field in that file is being

updated.

¢ Member X-ref: Displays source lines where the variable has been used, for the Source Member
displayed.

Let us examine these options.
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Variable Where Used

Variable Where Used (VWU) lists all the Source Lines where the field/variable of a file/program has
been used/referenced in the Member source and its associated Device Files and Copybooks, through
out the application.

A wide variety of items can be specified including:

Files, Array definitions, Data Structures, Data-Structures sub-fields, Indicators, Key Lists, Data Fields,
File Formats, Subroutines, Program Variable, Array Elements, Parameter Lists, Parameters, Key Fields,
EXCPT Names.

On Source browser view, take VWU on CSNAME field in OEQ01 program.

il X-Analysis - Source List of FAXSHT1 in CUSLIB/QRPGSRC Lines: 53, Yiew Level: 5

File Application  Action  Wiew Objeck  Window  Help

el & |® & F 5% 8 00 o e o 06| s |
 gec. No.*...4... 1 ...+ .. 2 .cotiie 3 +oobeee 4 2ot 5 oot B oL
a0 [} MOTE C1IS CLUSND
ooiz2.00 C CALL 'WE:L
0o01z.00 C PLRM = Zoom Source
ooi4.00 C FAEHN
0015. 00 C* Proceed only if fax nudber 1 EACatE Flow Disgran
00lea.00 C AF L0 CABEQ*EL. B Structure Chart Diagram
0o17.00 C z_appl | MMProgram Structure Chark
001,00 c F_ADD1 BlCata Modeling Diagranm
ooi9.00 C MOVELEF AL L ;
aozo. oo o AF DOWLE19 File Figld De.talls
ooz 1,00 o aw ANDLEZ __ acreen Design/Report Layouk
oozz.oo C RFX, BF IFGE 0 &% CObiect Where Used
Qoz3 .00 C AFX,AF ANDLE' 9! 5 variable Where Used
nnz 4. 00 Q MOVE [Fx,  Variable Where Defined

AT 4 Warizhle Where |Indaked

Variable where used on a field used in a program

» X-Analysis - Yariable Where Used for *ALL/CUSNO Lines: 106, ¥iew Level: 1
File Application  Ackion  Wiew Object  ‘Window  Help

- Qs t\iﬂ%ﬁ-’hm\@nmsw P3G DHD. 036 WERE2I=E
Gource Memwber | Sedq. No. | R T S - T T T B - I S -
CIUSCPY oo5s. 00 C ADD 1 CUSHO

CUSCPY ao74, 00 C ICUSHC CHLINSECF a3
CUSCPY oo7e,. 00 C Z-ADDCUSIIO SCUINO

CUSCPY ao7s. 0o C ICUSO RELDESECF 83
CIUSF 00z 6. 00 A CUSHC SF 0O TEET('Cus. Ho.')
CUSFL3 ooos. 00 A K CUSHO

CUSFMAINT o044 .00 C cusno chainie) rocust

CIT3FHATINT o09a.00 C eval ZCUSNO = CusSno

CUSFHAINT 01z4.00 C eval Cusho = ECUSno

Variable where used view for a field

Besides other options on right-click menu, File/Field where used and File/Field where updated options
are also available on PF/LF source browser view. Here, double-click on the field presents File/Field
where used source lines, i.e. those source lines which use the field of that specific PF/LF.
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Variable where used for*ALL/CSNAME implies that all the source lines using the field name CSNAME,
irrespective of the file to which it belongs will be presented on the VWU view.

This Tool bar button brings up a dialog prompting for File and Field to perform Variable where
used on. The VWU can be made on *ALL or specific file.

Yariable Where Used x|

File Field

|

] I Cancel

Variable where used dialog

View Levels

Variable where used allows for seven levels of VWU viewing. The Variable where used request always

produces Level 1 information. Higher VWU levels can be requested using View Menu. The VWU levels

present the following information:

e Level 1: Direct references to the field.

e Level 2: Direct references to that field and references to any other field that references the first
field.

e Level 3: All of the above and also further indirection/references to the field in level 2 referencing
the first field.

o Level 4/Parameters: All of the above and also references where the Field has been passed as
parameter.

e Level 5/Cascading Parameters: All of the above and also references where the Field has been
passed as parameter in a function which is in turn being called by another.
Level 6/Aliases: All of the above and also references to all the aliases of the Field.
Level 7/Maximum Tracking: Tracks the usage of variable or field to maximum level of indirection.

Source Member | Seqg. Mo. | T e T e P
CPDM ooaoz._ao DCL VAR (aACUSNO) TYPE(*DEC) LEN(S 0}
CPIM oolo.ao CHGVAR 4LCUENO SCUENC

VWU for *ALL/CUSNO, Level 1

Source Member | Seq. No. | WS, d bt s e G d e Bk e e gy G e
CPDHM ooos. 0o DCL VAR(aCTUSHO) TYPE(*DEC) LEN(:S 0]
CIDHM oooe._ 0o DCL VAR(SCTUSHC) TYPE(*CHAR) LEN({L)
CPDH ooos._ 00 CHGWAR  &CUSNC sTH

CPLH oolo. oo CHGWAR &CUSHNO &CUEHC

VWU for *ALL/CUSNO, Level 2

ISDurce Menher | Seg. Mo. | T e T T
CPI'M o003 a0 LCL VAR(&ACTUSNO) TYPE(*DEC) LEMN(L 0O}
CPIM ooo&. a0 DCL VAR(&CUSNC) TYPE(*CHAR; LEN(E);
CPIM ooo7._ oo LCL VAR{aprefix) TYPE(*CHAR) LEN(L)
CPDM ooos._ oo CHGVAR 4SCUSNC &oTE
CPIM oolo. oo CHGVAR 4aCUSNO SCUTSNC

VWU for *ALL/CUSNO, Level 7

© Copyright Databorough Ltd. 2005 Page 46



X-Analysis for Windows User Manual Information about an Object

Note, more source lines are presented as higher level of VWU is viewed.

Variable Where Defined

Displays the source lines where the variable was defined. Source Line where the variable CSNAME
gets defined:

" X-Analysis - Yariable Where Defined for OEOD1 /CSNAME Lines: 1, Yiew Level: 1
File Application  Acktion  Wiew Object ‘Window Help

& & b TS '1..|@DFD SO0 PAC OMD 030
Jource Member |Seq No. |*...+ L oocodFoce & coodfoco & ocooiFooo
OEQOLDF o043 .00 i C3NAME 344 O

Variable Where Defined for OE001/CSNAME

Variable Where Updated

This is same as Variable Where Used, but displays only those source lines where the variable is
updated. Source lines where Variable CNAME gets updated:

i X-Analysis - Yariable Where Updated for *ALL/CNAME Lines: 5, ¥iew Level: 1
File Application Action  Yiew Object  Window Help

[& &

| &

S| @ BT '1-|@DFD S0 P3N 066

Jource Member Seq No. E L coodFoces & cocdFoco & ooodfe

CTUSCPY

MCVELCI AME INANE:

[
CUSFHAINT o1z5.00 C eval Ccrname = ZChame
QEOOS aoze.00 C MOVEL *ELANES CHAME
QEOOS o114.00 C MOVEL *ELANES CHAME
WECUIP oos1.00 8] CHAME + 1

Variable Where Updated for *ALL/CNAME

If the application is initialised without source code, then the following options are disabled:
Source Zooming

Program Structure Chart

Field Usage

Detailed Data Flow Diagram

Variable Where Used

Variable Where Updated

Variable Where Defined.

Nouhwne
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8. File/Field Where Used

The File/Field Where Used option is only available on FILE type objects. This option displays the
usage of a field in the entire application.

» X-Analysis - Yariable Where Used for CUSF/CNAME Lines: 34, Yiew Level: 1
File Application  Ackion  View Object  ‘Window  Help

el als|BndsdT s "1.|@[:|H:| S P60 0|
Source Member Seqg. No. kel b EEEEEEREEE ST SRAEIAER I Coniaobht FEHEHTLHAY A
CUICPEY ooi4 .00 I AL
CUO3CPY ooz .00 I CHALME
CUO3CPY ao3a. 00 C MOVELCIAME
CUO3CPY o039, 00 C MOVELCIAME
CUO3CPY o043 .00 C MOVELINAME
CUO3CPY aoso. 0o C MOVELINAMEZ
CU3ICPY aos9.00 C MOVELCHAME
CU3ICPY aogs . oo C EFLD
CU3F aooz .oo 4 CHAME 4L
CU3IFLA aoos . oo 4 E CHNAHME
CUSFLAX aoos . oo 4 E CHNANE
CTEFLE ooos .00 4 E CHNANE

File / Field Where Used for CUSF/CNAME

File/Field Where Updated

This option is the same as File/Field Where Used, but displays only those source lines where the field
is being updated.

» X-Analysis - Yariable Where Updated for *ALL/CNAME Lines: 5, Yiew Level: 1
File Application Action  Yiew ©Object  Window Help

| &

RS & BT '!.|@|:|Fn 500 PAG 0D O
Source Member Seq. No. Fooatee 1l L+l 2 0t ll. 3

C oos5e.0o C NCOVELCHAME INAMEZ
CUSFHAINT 0125.00

C eval Cchame = EZChatne
QEOOS ooz27.oo C NOVEL*ELANES CHANE
QEOOS O011s.00 C NOVEL*ELANES CHANE
WECUIP oos31.00 o CIHAME + 1

File / Field Where Updated for CUSF/CNAME

Both File/Field Where Used and File/Field Where Updated options are specific to Source Browser
view and are available only when browsing *FILE type objects.
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Member X-Reference

Member X-Reference lists all the Source Lines where the field/variable has been used / referenced, in
the Member source and its associated Device Files and Copybooks.

A wide variety of items can be specified including:
Files, Array definitions, Data Structures, Data-Structures sub-fields, Indicators, Key Lists, Data Fields,

File Formats, Subroutines, Program Variable, Array Elements, Parameter Lists, Parameters, Key Fields,
EXCPT Names.

Double-click on a field in member source presents the Member X-Reference view. Alternatively,

choose Member X-ref option on right-click menu.
o0=4.00 C* Initialise sScreen

MOVE LCHD

[
0026 .00 C MOVEL*EL  CMD,1
0oz .00 C MOVEL *EL
0o0z2s.00 C MOVEL *BL [ Z00m Source
0029 .00 c MCOVEL *EL _
0030.00 c MOVEL *BL KA ata Flaw Diagram
gos1i.00 C - 10D+ 2 F ISt ockure Shark Diagram
ao3z .oo * Retriewe last order number JlProgram Struckure Chark
0033 .00 C *HIVAL SETGTCUS P0ata fodeling Diagram
oo34.00 C FRELDPCUS
ao35.00 C *TN40 IFEQ *ON  Fle Field Details
D03 6.00 c Z-ADD1 Sereen Design/Repart Layout
ooz7 .00 C ELZE .!i‘-;'.:'i-ﬁOb' twh o
0038 . 00 c CUSNO ADD 1 oL et e
o039, 00 C END §a Yariable Where Used
oo40.00 w Yatiable Where Defined
oodl. oo C HOVEL'O' yariable Where Updated
oo4z .00 C MOVEL' 1! W _pef
0043 .00 oF =

“Member X-Ref on a field used in a'i:rogram

When the Member X-Reference for a sub-item (such as a Data-Structure sub-field, Array Element or
File Format) is selected, a list of the sub-item, along with all the references to the parent items, is
displayed. Double-click on the source line to view the source of the object.

i+ X-Analysis - Member X-Ref for CMDDTA in CUSLIB/QRPGSRC{OEODO1), Lines: 4
File Application Acktion  Wiew Object  Window Help

|e|R&|e | B & T 5 5| B 0 5 oo |
Jeqg. No. Y. ooooo d sostoos B coocifooo & cooFooo B oooTPooao 4

00=5.00 C MOVEACHD, 1 CHDDTA
oosl.00 C MOVEACHD, 3 CHDDTA
oYz .oo C HOVEACHD, 2 CHDDTA
oove.oo A CHDDTA TEA O 24 2

Source lines of object(s) using the field

Note that the last source line comes from OEQ01DF, a device file. Double-click on this line to zoom
into OE001DF source.

Member X-reference allows for five view levels, discussed under Variable where used.
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Appendix A — Troubleshooting

Troubleshooting Specific-user mode

User might face problem(s) using X-Analysis in Specific-user mode because of one or more reasons
listed below:

1.

Missing JAR/DLL. The following should be available under *..\Databorough\lib” folder:
boot.jar

jface.jar
runtime.jar

swt.jar
workbench.jar
jt400.jar
izmado.jar

poi.jar

batik.jar
xmirpc.jar
inwords.jar
jsf-impl.jar
jsf-api.jar
swt-win32-2136.dll
izmjniado.dll

If anyone of them is missing, X-Analysis Pre-Requisites should be installed again.

The Java bean DLL, XBrowselInvokerBean.dll, might not be registered. Please check for the
following:

1. <JRE_HOME>\axbridge\bin\XBrowselnvokerBean.dll

2. <JRE_HOME>\axbridge\lib\XBInvok.jar

<JRE_HOME> is e.g. C:\Program Files\Java\j2rel.4.2_05.

If either of them is not found, copy the axbridge folder under “C:\Program Files\Databorough\X-
Browse” to <JRE_HOME> and run the following command on Command Prompt:

regsvr32 "<JRE_HOME>\axbridge\bin\XBrowselnvokerBean.dlIl".

Regsvr32 is under system folder, C:\WINDOWS\system32. Change path to system folder in case
command does not run.

Either java.policy file does not exist in <JRE>\lib\security folder OR if exists, does not have
“..\Program Files\X-Browse” entries.

In case java.policy file does not exist, copy it from “C:\Program Files\Databorough\X-Browse" to
<JRE_HOME>\lib\security folder. Add the following section at the end of the file.
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grant codeBase "file:C:/Program Files/Databorough/X-Browse/lib/*" {
permission java.security.AllPermission;

h

grant codeBase "file:C:/Program Files/Databorough/X-Browse/lib/*" {
permission java.security.AllPermission;

+

grant {
permission java.util.PropertyPermission "user.home", "read";
permission java.util.PropertyPermission "user.dir", "read";
permission java.io.FilePermission "C:\\Program Files\\Databorough\\X-Browse\\-", "read,

write, delete, execute";

)

4. Logoff after performing the above changes.

Following are some additional Troubleshooting tips to help deal with minor problems.

Problem encountered Probable Cause
Application does not start with iSeries online | A connection must be established prior to
option. running the Application with iSeries online.

Cannot see the preview of the | A printer must be installed and configured for
diagrams/charts from the Application. to preview diagrams/charts.

Running with PC Database does not start the | The Database to be used must be registered
Application. with ODBC.

The existing fonts do not print correctly on | The option exists to alter the font. The
the diagrams/charts. selected font is reflected on all the diagrams.
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Initialisation Reports

When intialising an iSeries Application for X-Analysis using XA4INIT, the command also produces the
log reports. The log reports generated are categorized as:

e Program Reference Exclusions e Missing Object and Source

Program Reference Exclusions
These exclusions are specified in file XAN4/XPGREXCS.

X-Analysis is shipped with file XPGREXCS containing values QRN*, QLE*, QC*, QM*, QS*. The file is
duplicated into the user's X-Analysis library.

Any program reference specified in this file is excluded from the X-Analysis program cross-reference
database X@XPGRF.

Two reports are produced to list all actual exclusions:
e Program XARRMIVN reports on exclusions from the DSPPGMREF output.
¢ Program X@PMX1 lists exclusions from the QBNLPGMI output.

Missing Object and Source

Various programs in the X-Analysis initialisation process write mismatches to a log. These mismatches
are printed out under the following headings:

e References to Objects not loaded
e References to Sources not loaded
e Source Code without Objects

The above reports assist user to interpret the outcome of the XA4INIT command run on an iSeries
application.

Configuring X-Analsyis for Generic User mode
Configure XRMTCMD to use Generic mode ONLY if for some reason user specific mode fails.

(Only if TCP/IP connection is going to be used)

Create the XRMTCMD environment

You should have signed on as Security Officer or equivalent at this point in order to create the
required user profile.

Execute the command MMC@INST in library XRMTCMD

XRMTCMD/MMC@INST
and press F4.

Installation of XRMTCMD (MMCEINST)

Type choices, press Enter.
IiOEEAEY o o o o o o o o o o o XRMTCMD Character value
Password . . . . . . . . . . . XAN4 Character value
Bottom
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F13=How to use this display
F24=More keys
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The library must be XRMTCMD. If another library is specified the TCP/IP connection may not work.
The Password is the password used to logon to X-Analysis from the PC.

This creates a user profile and a message queue both named XRMTCMD.

The subsystem XRMTCMD is also started.

@\ The password is required by the Windows user to sign on.

& The following needs to be added to the IPL procedure.
STRSBS XRMTCMD/XRMTCMD

If the MMC@INST is run with insufficient authority, then:
e Stop the XRMTCMD subsystem.
e Run the MMC@INST command again, with the required authority.
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Advanced Toolbar and Menu options

Tool bar buttons

Appendix B - Advanced

Toolbar and Menu options

The tool bar buttons not available with basic X-Analysis are tabulated below:

Function
Source Editor
(SEV)

Screen design

Documenter

Annotate

Annotate Field

Overview
Structure Chart
Data Model
Diagram

View Data/
Re-engineered
Components

Invoke X-Browse
on Data
Dictionary

Open Websphere
Studio

Button
S

—_

28 & ¢ WM |
=1 Lo} =

e ®

Purpose
Invokes iSeries Source Editor.

Displays the Screen design for the specific
object.

Invokes the Document Manager to assist
in generation of Application Document.

Opens a word document to associate an
annotation with the selected object.

Opens a word document to associate an
annotation with the selected Field.

Displays the Overview Structure Chart for
the entire Application.

Displays Data Model Diagram for the
selected Application Area. If no Application
Area is specified it displays Data Model
Diagram for the entire Application.

Invokes X-Browse (if installed) on the local
machine for the selected PF. For Programs,
list of Re-engineered Components is
presented. User can invoke X-Browse for
the function or Zoom on Shadow Program.
Invokes X-Browse (if installed) on the Data
Dictionary generated by XREV

Opens the Websphere Studio. Only
available on the Business Rules/JSFs View.

© Copyright Databorough Ltd. 2005

Page 54



X-Analysis for Windows User Manual

Advanced Toolbar and Menu options

Menu bar items

The Menu bar comprises the following menus and menu-items.

Menu-items on the menus are enabled, disabled, added and changed depending on the view.

Menu / Menu-item
File

File Application Action  Wier

Connection

Print. .. Ckrl+P
Prink Presiew
Prink Setup...

Export ko Ward

Return
Exit

Application

Mew ...
Properties ...
Delete

Cpen Application Folder

Documenter

Action

Jurnp ko
Position to
Search Description

Object Lisk
Member List

Variable Where Used
Variable Where Updated

Dweryiew struckure Chark
[raka Modeling Diagram

Bookmark ...
Document this lisk ...
Expork bo M5 Visio

Inwioke #-EBrowse for Data Dictionarsy

Purpose
Export to Word: Available on Object/Variable where used
lists.

New: Allows adding of a new Application area.
Delete: Delete a selected Application area.

Open Application Folder: Opens application specific folder
listing the files in it.

Documenter: Invokes the Document manager.
Data Modeling Diagram: Displays the Data Model
Diagram for an application

Document this list...: This option starts documenter for
current list.

Overview Structure Chart: Displays the Overview
Structure Chart for an application.

Export To Visio: This option exports current Data Flow
Diagram to Visio.

Export as XMI: Exports Data Model information to XMI
format.

Export as DDL: Exports Data Model information to DDL.
Both the Exporting options get enabled only in DMD view.

Invoke X-Browse on Data Dictionary: Invokes X-Browse
on Data Dictionary information produced by X-Rev.
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View

Defail

Expand Level
Zollapse Level
Expand All

Subset
Refresh

Source Level

Source Code

Indented Source

Pseudo Code

Business Rules Code
Business Rules Pseudo Code

Flowchart in M5 Yisio

Large Fonk

Object

Z00m Source
Where sed

Source Editor (SELY
screen Designf/Report Lavouk

Data Flow Diagram
Structure Chart Diagram
Program Structure Chark

Annotate

Annatate Field

Mark For Documenter
Mark all For Dacumenter

Invoke XErowse

Detailed DFD/DMD/SC: Brings up the detailed view of
Diagram/Charts.

Available only on Source Browser view:
Source Level: Displays various levels of the source code.
Indented View: Displays the indented view of the source.

Pseudo Code: Available on Source browser View. Presents
the Source lines in the form of English Statements.

Business Rules Code: Available on Source browser View.
It highlights business logic code, at different levels.

Business Rules Pseudo Code: The Source Code in the
Business Rules Code view is displayed in the form of Pseudo
Code.

Flowchart in MS Visio: This option appears in case of
*PGM type files and exports its flowchart into MS Visio.

File Specification: This option is shown when browsing
PF/LF source. It displays the record format and key fields.

Source Editor (SEU): Invokes iSeries Source Editor.
Screen Design: Screen Design as on iSeries.

Program Structure Chart: Presents object’'s Program
Structure Chart

Annotate: Displays Word document to annotate the object.

Annotate Field: Displays Word document to annotate the

field.
Mark for Documenter: Marks the object for
documentation.

Mark all for Documenter: Marks all the objects in current
view for documentation.

Invoke X-Browse: Invokes X-Browse (if installed) on the
local machine for the selected PF. For Programs, list of Re-
engineered Components is presented. User can invoke X-
Browse for the function or Zoom on Shadow Program.
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Right Click Popup Menu on View

This menu pops-up when an object or a source line is right clicked.

COMNOOL

Foom Source

&5 Data Flow Diagram

%= Structure Chart Diagram
£ Program Structure Chart
B Cata Modelling Diagram

File Field Details
acreen Design/Report Layouk
L Object Where Used
¥4 Yariable Where Used
Wariable Where Updated
[iFs [ fccess Paths
MMember K-ref

Annokate
Annotate Field
Mark For Documenter

Mare Info...

Detive Business Rules
Re-enginest Bus. Rule Programs
Wiew Bus. Rule Programs/]SFs

add to Application Area
add ko Application Area with Related Objects
Cmit From Application Area

Program Structure Chart: Presents object’s
Program Structure Chart

Data Modeling Diagram: Displays object’s Data
Model Diagram

LFs/Access Paths: Replaces Source X-reference
option when working with Physical Files

Screen Design: Displays Screen Design

Annotate: Displays Word document to annotate the
object.

Annotate Field: Displays Word document to
annotate the field.

Mark for Documenter: Marks the object for
documentation

More Info...: Object details like name, library, type,
attribute, etc.

Derive Business Rule: Extract Business Rules.
Re-engineer Program: Creates Shadow Program.

View Data/View Business Rule Programs/JSFs:
Invokes X-Browse for the selected PF. For Programs,
list of Re-engineered Components is presented. User
can invoke X-Browse for the function or Zoom on
Shadow Program.

The Program Structure Chart, Screen Design, Mark
for Documenter options, along with the three
Application Area Maintenance options will only be
enabled if the Application Area Module is purchased.
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The List of Application Libraries View has its own Right-click popup menu.

Right-click menu on the X-Reference Library

New Application Area: Allows adding of an Application
area.

View Archived Records: Opens X-Browse to display
archived records.

Subset Entire Library: Submits a batch job to produce
subset of entire library.

Derive Business Rules: This command uses the X-
New Application Area Analysis and X-Rev databases to reverse engineer all
relevant functionality from legacy programs in the X-
Reference Library.

Wiew Archived Records
Subset Entire Library

Detive Business Rules Re-engineer Bus. Rule Programs: This option re-
Re-engineer Bus, Rule Programs engineers functions from an existing program.

Wiew Bus, Rule Programs/JSFs

Generate J5F and Javabean(s) View Bus. Rule ProgramS/JSFS: Displays all the

Business Rule Programs / JSFs.
Expork as wMIL
Export as DOL Generate JSF and Javabean(s): This would configure
the project (if it has not already been configured)
with the same name as APPLIB, generate the ]SF
page and bean of Business Rule Program and finally
launch the WDSC.

Relationship Field Matching
Regenerate Daka Model and Functions
Regenerate Functions

Remoyve Spplication Lack

Relationship Field Matching: Allows XOVRALIAS
Maintenance.

Regenerate Data Model and Functions: Starts
XDMODEL in batch by locking the application.

Regenerate Functions: Starts batch building of functions
by locking the application.

Remove Application Lock: Unlocks a locked application.

Right-click menu on the Sub-library

Orphaned Records Report: Displays report of records
whose parents do not exist. This is available on Verification

and Subset library.
Orphaned Records Report

ek i this lorary Reinstate: Reinstates archived records. Available only on
Reeturn to Initialised Library Archive library.

Reinstate Work with this Library: Selects the library as data
Wiork with Ehis library library.

Return ko Initialised Library
Return to Initialised Library: It reverts to the initialised

X-Analysis data and X-reference library.
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IUpdate Application &rea
Remove Application Area
Application Area Rules

Generake X-Browse Application
Derive Business Rules
Re-engineer Bus. Rule Programs
View Bus, Rule Programs/J5Fs
Generate J5F and Javabean(s)

Expork as #MI
Export as DoL

Work with Objects
Docurment Application Area
Verify Data Relationships
Set Subset/Archive Filker
Subset Daka

Archive Data

© Copyright Databorough Ltd. 2005

Update Application Area: Allows updating of an
Application area.

Remove Application Area: Allows deleting of an
Application area.

Application Area Rules: Allows maintenance of
Application area rules.

Generate X-Browse Application: Creates X-Browse
application on the files in application area.

Derive Business Rules: This command uses the X-
Analysis and X-Rev databases to reverse engineer all
relevant functionality from legacy programs within the
application area.

Re-engineer Bus. Rule Programs: Re-engineers
programs in the application area.

View Bus. Rule Programs/JSFs: Displays the Business
rules programs in the Application Area.

Generate JSF and Javabean(s): This would configure
the project (if it has not already been configured)
with the same name as APPLIB, generate the JSF
page and bean of Business Rule Program and finally
launch the WDSC.

Export as XMI: Exports Data Model information to XMI
format.

Export as DDL: Exports Data Model information to DDL.
Both the Exporting options get enabled only in DMD view.

Work with Objects: Brings up the Work with Object
dialog.

Document Application Area: Invokes System
Documenter on the objects held in an application area.

Verify Data Relationships: Produces a verification report
listing records breaching the relationship integrity.

Set Subset/Archive Filter: Invokes X-Archive Application
to set Archive Filter.

Subset Data: Submits a batch job to produce data subset
on the subset filter specified for that application area.
Archive Data: Submits a batch job to produce archive
data on the archive filter specified for that application area.
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The module wise details of the advanced toolbar and menu options are as follows:

Module Advanced Options Available

Source Levels

Source Code

Indented Source View

File Specification View
Pseudo Code

Business Rules Code
Business Rules Pseudo Code

Application Overview

SEU
e Screen/Design Report Layout

¢ Flowchart in MS Visio
e Export to MS Word
Export to MS Visio

Mark for Documenter
Document Manager dialog
Mark all for Documenter
Document this list...
Annotation

Program Structure Chart
Overview Structure Chart

Delete Application Area

Update Application Area

New Application Area

Application Area Rules

Document Application Area

Add to Application Area

Add to Application Area with Related Objects
Omit from Application Area

Open Application Folder
¢ Change Application Folder

Subset Data e Subset Data
e Set Subset / Archive Filter
Subset Entire Library

Data Model Diagram Data Model Diagram
LF/Access Paths
Regenerate Data Model and Function

Data Dictionary
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Archive Data e Archive Data
View Archived Records

View Data Regenerate Functions

Relationship Field Matching
Regenerate Data Model and Functions
View Data

Generate X-Browse Application

Verify Data e Verify Data Relationships
Relationship

Business Rules Code

Business Rules Pseudo Code
Re-engineer Bus. Rule Programs
Derive Business Rules

View Bus. Rule Programs/JSFs

Business Rules

© Copyright Databorough Ltd. 2005 Page 61




X-Analysis for Windows User Manual Licence Code Request Form

Appendix C— Licence Code
Request Form

X DATABOROUGH

Eegacy enhancement solutions

License Code Request form

Kindly complete and confirm the details below and fax this form to: +44 1932 859211
Alternatively this can be emailed to sales@databorough.com

Company

Contact name

Contact email

Telephone

Fax

Address

Post Code

Country

iSeries Serial No.

Model

Feature Code

Purchase Order No

Agent or Distributor

Comments

If software is required to be sent and the iSeries is not located at the same address as indicated above please
provide the appropriate delivery address and contact details below.

iSeries Contact

Contact email

Telephone

iSeries Address

Post Code Country

Requested By Date

Position

Unit 12b, Weybridge Centre, 66 York Road, Weybridge, KT13 9DY, United Kingdom Tel: +44 (0) 1932 848564
Company Registration Number: 01795263 VAT number: 492 6942 05
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Appendix D - Invoking X-
Analysis from WDSC for iSeries

In order to invoke X-Analysis from Websphere Development Studio Client for iSeries, the
WDSCXAInterface Plug-in is required. The Plug-in is shipped with X-Analysis and on installation it is
copied at the following location:

C:\Program Files\Databorough\X-Analysis\WDSCPIlugin

If WDSC for iSeries is found on the machine, the plug-in is also placed at:

C:\Program Files\IBM\WebSphere Studio\Site Developer\v5.1.2\eclipse\plugins\
com.databorough.xanalysis.wdscxainterface_1.0.3

THE SUPLLIED PLUG-IN WORKS WITH WDSC 5.1.2.

Start Websphere Development Studio. To ensure that the plug-in is installed on the machine. go to
Help > About Websphere Development Studio Client for iSeries. On the presented dialog,
click Plug-in Details button. The following dialog is presented displaying the Plug-in Name, its
provider and the version.

&P About WebSphere Development Studio Client for iSeries Plug-ins

Provider | Plug-in Marne | Yersion | Plug-in Id | A
Databorough Led, Wiscxalnkerface Plug-in com.databar. ..
Eclipse.org Agent Conkraller 1.0.3 org.eclipse.h...
Eclipse.org Ant Build Tool Core 2.1.3 org.eclipse.a...
Eclipse.arg Apache Ank 1.5.3 org.apache. ant
Eclipse.arg fpache Lucene 1.2.1 arg.apache.l. ..
Eclipse.org Compare Example z2.1.0 org.eclipse.c...
Eclipse.org Compare Support 2.1.0 org.eclipse.c...
Eclipse.org Core Book 2.1.3 org.eclipse.c...
Eclipse.arg Core Resource Managemenk 2.1.1 org.eclipse.c...
Eclipse.arg Caore Runtime 211 org.eclipse.c...
Eclipse.arg WS 35H Care 2141 arg.eclipse.t...
Eclipse.org %3 Team Provider Core 2.1.3 org.eclipse.t...
Eclipse.org WS Team Provider 1T 211 org.eclipse.t...
Eclipse.org Debug Core 21.2 org.eclipse.d...
Eclipse.arg Debug 1T 2.1.3 org.eclipse.d. ..
Eclipse.arg Defaulk Text Editor z.1.0 arag.eclipse. ...
Eclipse.org Drawzd 2.1.2 org.eclipse.d...
Eclipse.org Drawzd Docurnentation 2.1.2 org.eclipse.d...
Eclipse.org Eclipse Java Development Tools 2.1.3 org.eclipse. jdt
Eclipse.arg Eclipse Java Development Tools SDK 2.1.3 org.eclipse.j...
Eclipse.arg Eclipse Java Development User Guide z2.1.0 org.eclipse.j...
Eclipse.arg Eclipse 10T Plug-in Developer Guide z.1.0 arg.eclipse.j...
Eclipse.org Eclipse Modeling Framework (EMF) 1.1.1 org.eclipse.emf »

Plug-in Details Dialog on WDSC for iSeries
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Follow the steps below to browse a library using X-Analysis:

Manual

X-Analysis Plug-in for WDSC

Step 1: On WDSC for iSeries, go to Window > Open Perspective > Remote System Explorer.

4P Remote System Explorer - WehSphere Developm® _

Edit Mawigate Search Project

File

Cgcxa  Xandtskza  xar

B-HES | BB H % - &

=

UE remote Systems

v X

"B

2P| s

k.

i

L

+ & Mew Conneckion

+ 'E, Local

Remote System Explorer Panel

Step 2: Expand the New Connection node. Further, expand iSeries... node.

4¢ Remote System Explorer - WebSphere Developh

Edit Mawigate Search Project

File

=

®

Cgoxa  mandkskxa

"HES || SSS 3 -

E’ Remake Systems

Eh| oo

oM

-

&

%

+- i Windows. ..
+ f} Lirwe,..
+-Unix LRz, ..
+-B Local,..

+ & iSeries...

- 4}_ Mew Conneckion

Remote System Explorer - Expanded
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X-Analysis Plug-in for WDSC

Step 3: The
Remote iSeries
System

Connection Dialog
is presented. Enter
the Connection
Name, the Host
Name and click on
the Finish button.

Step 4: A Sign On
Dialog is presented.
Enter the User Name
and Password for the
host.

% New

Remote iSeries System Connection

Define connection information

Parent profile: | Mark

Connection name: | 60,177.85,158

Host name: | 60.177.85.158

Description: |

[v Yerify host name

| Mext = | Finish |

Zancel

4k Enter Password @

Swskem bype: iSeries

New Connection Dialog

Hosk name:  60,177.55.155
User ID: | us
Password: | bbbk

[V Save user ID

Cancel
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&P Remote System Explorer - WehSphere Develop
Step 5: A new

connection by the File Edit Mavigate Search Project Cgoxa  Xandkskxa
namespecifi_edas 8 1 Sl ¥ -
the Connection : =
Namein the ME Remote Systems e - ¥
previous dialog is N8| e e &
added. Al the %: > & R
libraries in the host &= E‘J’:W onnection
computer may be +-iif Windows...
viewed by expanding e f? Line. .
the Library List. * Uni Lris....
However, to view + E ;DE*?'---
only selected = ISENES. ..
Iibrgries, a Library - lv| Cannection created successfully, Expanc
Filter has to be * 'y Local
created. =-Ea
=gy iSeries Objects
+ ﬁ work with libraries, ..
+ 'ﬂj' work with objects. .,
+ ﬂj’ Work with members, ..
+ W Library lisk
+ iﬁb User libraries
+ ¥ iSeries Commands
+- gy iSeries Iobs
+|- Ty IFS Files
New Connection Added
Step 6: Expand ]
Work it < New X
Libraries node | Library Filter ;
und_er Ise"e_s Create a new iSeries library filker =
Objects. This *'::!! >
prompts for

specifying Library
Filter. Enter the | Library:
iSeries Library Name.
Click Next.

jj Browse, ..

Mext = | Finish | Cancel

Add New Filter Dialog
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OO ]

Step 7: Enter a
Filter Name. Select
the Owner Profile
and click on the
Finish button.

4 New

Library Filter =
]

Mame the new Filter *:{>
=,

Filters are saved For easy re-use. Specify a unique name For this Filker. This name will
appeat in the Remote Syskems view, and will be expandable,

Filker name:

[ Only create filker in this connection

Select a profile to own the new filker, This determines if it is unique bo vou, ar
sharable by the team. It will be placed in the default filker poal For that profile.

Owner profile: | Mark =

|xan4cdxa

< Back Mext = | Finish | Cancel |
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S_tep 8 A new & Remote System Explorer - WebSphere Developii
filter is added. :

Expanding the File Edit Mawvigate Search Project Cgoxa  Xandtstxa .

node displays the e e R A O i i X -2
library added to :
the filter. E.g. in e remote Systems e v X
the adjacent T Ned|ao m| s
image the new -
filter ~xan4cdxa & | = New Connection
displays the library i windows. ..
XAN4CDXA  on £ Linux...
being expanded. + g‘ E""xi--

+ acal. ..

- & iSeries. ..

| Connection created successfully, Expanc
+ 'E, Local

-8y 60.177.85.158
- ED iSeries Objects
- ﬁ Wark with libraries. ..
[w] Filter created successfully, Expand
+ _EE)' Wark with objects...
+ _ﬂj' Wark with members. ..
+ ﬁ Library lisk

i, KAM4CDRA, *ib,prod
+ & iSeries Commands
+ 3 iseries Jobs
+- ¥ IF5 Files

New Filter Added
Step 9: Right Click on the Library Name and select X-Analysis > Browse In X-Analysis.
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T -" L ar ) nsu

I, N .
+- i User libraries | ‘

- xandcdxa
+- i
4
+ & iSeries Commands e
+ ﬁ. iSeries Jobs Go To '
+ %2 IFS Files Expand To »
&ﬁi‘-’ Refresh
Expand
sks (0 ikems)
#dd To Library List... ! | Description
@ Rename...
. Copy
Remote Systems | Team % Paste
5] Properties b 9 Delete...

Property |'-.-'a|ue
Atkribute  PROD

A show in Table

Mame S ANGCDRA P+ Find String. ..
Mumbe... 0 Change...
Source Q55 Save
Status QK Rt
Text estore, .,
Twpe *( [ User Actions 4
Create ideries Project | cocbar Dakaile | Tacke |iSavias T:

Browse In ¥-Analvsis

PronerkiesiRY
Right Click menu on iSeries Library

Step 10: The X-Analysis Login Dialog is (45 _ i
presented. Enter the User Name and Password ASATEIYEIE S OPT Q
of a valid iSeries profile and click OK. R

IP Address: 60.177.85.158
In case more than one X-References are build :
on this library, user is prompted to pick the Library: XAN4

one to work with.
User:

Password:

oK Cancel

X-Analysis Login

© Copyright Databorough Ltd. 2005 Page 69



X-Analysis for Windows User Manual - X-Analysis Plug-in for WDSC

Step 12: X-Analysis is invoked and after successful login, it will open up the Source File
Listing for the selected X-Reference library.

%, X-Analysis - Source File List for: XAN4CDXA Total Objects: 13
File Application  Acktion  Wiew Object  ‘Window Help

- Rk 5 B BT o
+ Wl 5TAMDEYXS - Standby project # | | Source Library | Saurce File
+ H] TELOCHZRF - TELOCHZRF W AM4CDEM FOgCRTCMD
+ ﬂ TELOCHZEA - TELOCHZXA KAN4CDEM QUCBLSRC
+ Gl TKLOCHZ¥B - TKLOCHZXE AAN4CDEM QCLSRC
+ ﬂ TRWSE - KAMNSCDEM QDDSSRC
@l X@MANRF - X@MAN & X@MAND iimgggm gﬂzﬁgw
+ ﬂ AANSZDEMRF - RAN4CDEMRF % A4 CDEM QRPGSRC
+ Wl #AN4CDEMRG) - KAN4CDEMRG S ANACDEM CRPGSRCREY
+ ﬂ XANACDYXA - XAN4CDEM Tutorial 5 wANGCDEM QSECTHT
+ ﬂ KAMNACDEW - Web demo application KANSCDEM Q5IE5RC
+ Gl wan4za - x-analysis EANSCDEM QEKLERC
+ gl %8r1 - Standby Web App HANSCDEA QRPGSRC

o W ¥ERWEASHA - Java Example AANSCDRA QRPGLESRC

""_Source File List in X-Analysis

Step 13: Insert another library into +- 38 Local
the Library Filter, say XAN4CDEM. - 8y 60.177.85.158
The new library is displayed along - iseries Objects
with the already existing libraries. =25 work with libraries. .
w| Filker created successfully, Expand tl
+ 'ﬂ+ ‘Wark with objects. ..
+ 'ﬂj' Work with members. ..
+| 3 Library lisk
+ i User libraries
I

Sl o andda
+- i, #AM4CDEA. b, prod
+- i, ®AM4CDEM. *ib, prod
iZeries Commands

+ Eﬂ{
+ % iSeries Jobs
+ ¥

IFS Files

New Library Added
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Step 14: Expand the newly added library and right click on any object. From the right
click menu select X-Analysis > Zoom In X-Analysis.

- iﬁb xandcdza
i, =AM4CDEA #ib,prod
=i, %8M4CDEM, *ib. prod
AACUSE, *pogm.rpg
CBC110.*pgm.clp

+

>
CLET.*pgrn.clp GoTo

*
CLETH.®pam.{ k= ooy in Table
CONDOL, *par

CPDM.*pgr.c -!;.ﬁ'ﬁ" Refresh
CSEC. *pgm.cl
CSECZ. *pgm.s
CSEC3 . *pgm.s
CUSCRY *parr R Rename. ..
CSFMAIMT ., *

CUSINIT.*FIQI'I ':EIFI':." sks I:D itElTIS:l
CUISLET. *pgm [ | ! | Description

CUSLETSO *p
119 FT1 *nar < Maove...

b 8 Delete, ..
Remote Systems | Team

Expand

i1-EH-F-E-E-B-E-EH-E-E-E-E-E-E-E

lpdate. ..
5] Properties = Change. ..
Property | Walue | Save,..
Attribute  RPG Restore...
Marne CEI0AR. ser Actions 3
Mumnbe... 0 ) ]
Setrvice Enkry Paoink #
Source  RAMN4CDEM A ¥ .
Status QK Debug As
Text Back-out accournt Debug (PrampE)(Fy ¥
Type *Pigm Run As 3

FunfPrompki 1)

Zoom In ¥-Analysis

Properties(B)

Zoom In X-Analysis Option
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X-Analysis is invoked and the source of the selected object is displayed.

%, X-Analysis - Source File List for: XANACDXA Total Objects: 13

File Application Action  Wiew Object  Window  Help

Eo

& & B &b JT MO
+ ﬂ STAMDEYRS - Standby project Source Library | Source File
+ @l TKLOCHZRF - TKLOCHZRF HAN4CDEM FOSCRTCMD
+ FH TRLOCHZRA - TELOCHZ®A XAN4CDEM QUBLSRC
+-FH TELOCHZXE - TKLOCHZXE HAN4CDEM QCLSRC
o g TR - HAMN4CDEM QDDSSRC
@l H@MANRF - X@MAN & X@MAND z:mgggﬂ gﬂ;ﬁgm
+ F %AM4CDEMRF - XAN4CDEMRF S AMACDEM ORPGSRC
+ JH %AMACDEMRQ - XAN4CDEMRO Y ANACDEM (ORPGSRCREY
+ JH XAN4CDXA - XAN4CDEM Tutorial %AN4CDEM QSECTHT
+ H] HAMNSCDEW - WWeb demo application HAMNGCDEM QSIGIRC
+ gl wan4xs - x-Analysis KAN4CDEM Q3KLSRC
HAMN4CDHA QRPGLESRC

o W “ERWEASKA - Java Example

Source List in X-Analysis

X-Analysis Plug-in for WDSC

The document highlights the X-Analysis plug-in functionalities.

Troubleshooting X-Analysis plug-in

In case of any problems, ensure the following:

1.

Start WDSC for iSeries again.

xanalysis.path=C:\ \Program Files\ \Databorough\ \X-Analysis\ \

Look for “com.databorough.xanalysis.wdscxainterface_1.0.3" folder under
“C:\Program Files\IBM\WebSphere Studio \Site Developer\ v5.1.2\eclipse\plugins\ folder.

Open wdscXalInterfaceResources.properties to confirm that it has the following:

If not found then copy it from “C:\Program Files\Databorough\X-Analysis\WDSCPIugin” location.
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